
Adobe GoLive 6.0 ReadMe 
 
Please read and understand the license agreement included with this software prior 
to installing Adobe GoLive 6.0. 
 
This ReadMe document contains last-minute product information, updates to the 
GoLive 6.0 documentation, and troubleshooting tips. For further troubleshooting and 
performance information, see the Adobe GoLive 6.0 User Guide or GoLive Help. For 
system requirements and installation notes regarding Adobe Web Workgroup 
Server, please refer to the separate ReadMe document contained on the Adobe 
Web Workgroup Server CD. 
 
For an overview of the GoLive 6.0 highlights, see the New Features document on 
the CD or in your Adobe GoLive 6.0 application folder. 
-------------------------------------------------------- 
 
System Requirements 
 
Windows 

• Intel Pentium II or faster processor (400 MHz or higher recommended)  
• Microsoft Windows 98, Windows 2000, Windows ME, or Windows XP 

operating system  
• 96 MB minimum of available RAM, 128 MB recommended  
• Default/Easy installation requires 320 MB of available hard-disk space, 

350 MB recommended 
• CD-ROM drive  
• 1024x768 monitor resolution recommended 

 
Mac OS 

• PowerPC processor  
• Mac OS software version 9.1, 9.2, or 10.1  
• 96 MB minimum of available RAM, 128 MB recommended  
• Default/Easy installation requires 241 MB of available hard-disk space, 

290 MB recommended 
• CD-ROM drive 
• 1024x768 monitor resolution recommended 

 
NOTE: Installation of Apple QuickTime 5 is also recommended. 
 
-------------------------------------------------------- 
 
General GoLive 6.0 Notes 
 
Important: Registration 
Please complete your registration. After installing Adobe GoLive 6.0, start it, and 
choose Online Registration from the Help menu to register your copy online. 
Alternatively, you can register your copy by filling in and mailing the registration card 
provided with Adobe GoLive. You must register to receive technical support. 
 



Serial Number 
GoLive 6.0 uses new serial numbers. You can find your serial number on the Adobe 
GoLive registration card. Use this number to initialize the program. If your serial 
number does not work, please contact Adobe Customer Support. 
 
GoLive 6.0 Educational Versions 
Please note that the GoLive 6.0 Educational version does not contain the following 
actions that are documented in the user guide and Online Help: 
- CSS Redirect.action 
- Key Press.action 
- Random Links.action 
- Text Swap (ID).action 
- Last Modified (form).action 
- Last Modified (ID).action 
- Clock Date (ID).action 
- Digital Clock.action 
- Print Document.action 
 
Adobe GoLive SDK  
GoLive 6.0 significantly improves the extensibility of GoLive. Developers have 
greater control over the GoLive application and also have improved development 
tools and an enhanced JavaScript debugger. 
 
New GoLive extensions are being created by developers all the time. You can 
download some of them from the Adobe ActionXchange site at 
http://www.actionxchange.com/ where a community of developers are regularly 
adding new extensions. 
 
Some great third party extensions are also included on the Adobe GoLive CD, 
located in the Featured Extensions folder. 
 
Documentation for building extensions, tools to help create extensions, and over 30 
pre-built sample extensions can be found in the Adobe GoLive SDK 6.0 r1 folder 
installed with the application. The latest versions of the SDK, including further 
documentation and additional samples can be found at http://www.adobe.com/golive. 
Refer to this site for any future updates regarding the GoLive SDK. Please review 
and agree to the SDK License Agreement before using the SDK. 
 
To install an SDK extension or sample, simply drag the extension folder into the 
GoLive Extend Scripts folder. Restart GoLive and the extension is installed. New in 
Adobe GoLive 6.0, you can enable and disable extensions by selecting or 
deselecting the targeted extension in the Preferences dialog box. 
 
Online Help 
Please note that you will find the most complete documentation on GoLive 6.0 
features in GoLive Help (accessed via the Help menu). This online help covers the 
entire content from the printed user guide and additional documentation regarding 
the following: 

• Actions 
• DHTML Timeline Editor 



• Defining CSS style properties 
• Web image file formats and settings 
• Editor for QuickTime 
• GoLive Web Settings 

 
Plug-ins 
The Plugins (Windows)/Plug-ins (Mac OS) folder is reserved for third-party Web 
browser plug-in extensions. Copy the contents of your browser’s plug-ins folder to 
the Plugins/Plug-ins folder in the Adobe GoLive 6.0 application folder. This gives 
GoLive 6.0 the same multimedia and viewing options as your browser. 
 
NOTE: Under Mac OS X, make sure to also copy the “QuickTime Plugin.plugin” file 
from the system’s Library/Internet Plug-ins folder into the GoLive 6.0 folder holding 
the browser plug-ins. Otherwise you will not be able to preview QuickTime files in 
GoLive 6.0 under OS X. 
 
Acrobat Reader 
Some of the accompanying documents are in Portable Document Format (PDF). 
Use Adobe Acrobat or Acrobat Reader to view these files. You will find the latest 
Acrobat Reader release on the application CD. You can also download it from 
www.adobe.com. 
 
 
Microsoft Common Control 
If you want to use GoLive for Windows without Internet Explorer installed, you 
should install the Microsoft Common Control Update, which is in the Extras/Microsoft 
Updater folder on the GoLive for Windows CD. Please read the license agreement 
located in the same folder before installing. 
 
-------------------------------------------------------- 
 
GoLive 6.0 Installation Notes 
 
Your copy of Adobe GoLive 6.0 has an installer application. Please note that GoLive 
6.0 cannot run from the CD; the components must be installed onto your hard drive 
and run from that drive. For details on the installation process, refer to the 
HowToInstall document on the CD. 
 
Note: Installers for both the Adobe Web Workgroup Server and the Adobe Dynamic 
Content Server Packages can be found on the Adobe Workgroup Server CD found 
in the back, inside cover of the Workgroup User Guide. 
 
Install and External FireWire Drives (Mac OS only) 
The installer may quit due to access denied errors when trying to install to an 
external FireWire drive. 
 
Windows Install Options 
The Typical Install option will install the GoLive 6.0 application, along with all 
components, to your hard disk, whereas the Custom Install option lets you choose 
which components and dictionaries you wish to install. 



 
You can re-use the installer application at any time to modify, repair or remove your 
installed version of GoLive 6.0. In order to re-install your existing GoLive 6.0 version, 
you must use the Remove option, which may also delete all your custom files (e.g. 
actions, shortcuts, site templates). You should always back up your custom files 
before performing a re-installation. 
 
Please note that you can install different language versions of GoLive 6.0 on one 
Windows machine.  
 
Mac OS Install Options 
The Easy Install option installs the Adobe GoLive 6.0 application along with all 
components. The Custom Install option lets you choose which components and 
dictionaries you wish to install. 
 
Installing Dictionaries 
When using Typical Install (Windows) or Easy Install (Mac OS), respectively, only 
the dictionaries corresponding to the product language are installed. Additional 
dictionaries of your choice may be installed using the Custom Install option. After 
completing the initial GoLive 6.0 installation, you can at any time add more 
dictionaries by starting the application installer again, and choosing Modify 
(Windows) or Custom Install (Mac OS). 
 
Modules 
Some of the GoLive 6.0 modules are disabled by default. You can customize the 
GoLive feature set by using the Modules Manager in the GoLive Preferences dialog 
box to enable or disable modules of your choice. 
 
SVG Viewer 3.0 
On Windows, the SVG Viewer 3.0 is installed automatically into your browser plug-
ins folders with the GoLive 6.0 installation. If you want to install the corresponding 
SVG components for Mac OS, use the separate SVG Viewer 3.0 included in the 
Extras/SVG 3.0. 
 
-------------------------------------------------------- 
 
Additional GoLive 6.0 Components and Helper Applications 
 
Templates and Samples 
GoLive 6.0 ships with additional ready-to-use templates and samples that will help 
you get started in creating static sites, dynamic sites, and in using new integration 
functionality. The following components are installed with the GoLive 6.0 default 
installation: 

• Site Templates: Eight GoLive 6.0 templates that you can use for creating 
new sites via the GoLive site wizard. 

• Dynamic Content Samples: Sample and instructional sites to help you get 
started with Dynamic Content functionality, complementary to Dynamic 
Content documentation in the printed user guide and GoLive Help. 



• Smart Objects Examples: PSD, SVG and LiveMotion 2.0 files with text 
variables that you can replace using the new GoLive Smart Objects variable 
support. 

 
Sample files for authoring in QuickTime using GoLive are also included and located 
on the GoLive 6.0 CD in the folder GoLive 6.0 QuickTime Samples. 
 
PHP, JSP and ASP Javascript Authoring 
GoLive 6.0 offers dynamic publishing support for PHP and JSP, in addition to 
extending existing ASP support. Significant improvements to server environment 
setup, dynamic site creation, and e-commerce integration highlight this release. 

• Pre-configured Servers: You will find a JSP and PHP server on the Adobe 
Web Workgroup CD found in the back, inside cover of the Adobe Workgroup 
User Guide. 

• XML Support: XML can now serve as a content source and is a point of 
integration for XML files authored, tagged, and exported from Adobe 
InDesign, and brought into GoLive via Dynamic Content where the XML 
content can be published to web-enabled devices. 

• Custom Merchant: By integrating the powerful e-Commerce software hosted 
by Evocative, Inc. and Plug’n Pay Technologies, you gain significant 
commerce transaction features without sacrificing creative and precision 
layout control or making a huge capital investment. 

 
Instructions for Installing Dynamic Content Examples — ASP —Local Server 
If you are running Microsoft Personal Web Server or Internet Information 
Server (IIS) on the same machine where you installed GoLive, proceed as 
follows: Create a virtual directory named "samples" pointing to  
<install dir>\Dynamic Content Examples\asp_vbscript\samples. In addition: 
 
For the e-commerce example, you need to edit the file 
config\datasources\test_cart.ecp to reference the URL of a Custom Merchant 
e-commerce provider. This should be the test provider that is part of the 
preconfigured server package. Its URL is 
http://localhost:82/CMServer/test_cart.php (host and port depend on 
installation; localhost:82 is the default for a local server for Windows 
platforms, localhost:8200 is the default for Mac OS X-based platforms). 
 
Instructions for Installing Dynamic Content Examples — ASP —Remote Server 
You will need to upload the contents of: 
 
<install dir>\Dynamic Content Examples\asp_vbscript\samples 
 
Create a virtual directory named "samples" pointing to the uploaded site. In addition, 
you will need to update the following files: 
 
For the Calendar example, update the XML datasource file.  Choose 
config\datasources\Calendar.xds, and  change the URLs to reference the site on 
your server. 
 



For the e-commerce example, update the e-commerce provider file 
(config\datasources\test_cart.ecp) to point to a working provider such as the one 
included with the preconfigured server package 
(http://localhost:port/DCServer/test_cart.php). 
 
Instructions for Installing Dynamic Content Examples — PHP 
The easiest thing to do is to install the preconfigured server package. To install the 
sample sites manually, create an alias or virtual directory named "samples_php" that 
points to: 
 
<install dir>/Dynamic Content Examples/php/samples 
 
For purposes of using the samples, you will want to have the MySQL database 
running. To create the database used by the samples, point your browser to: 
 
<http://localhost/samples_php/config/datasources/mysql_install_databases.php> 
 
This page will create the databases used by the sample sites. You will only have to 
do this once. If you need to specify a server, database name, user name, or 
password for your MySQL installation, you can add URL parameters to 
mysql_install_databases.php for dbserver=, dbname=, dbuser=, and dbpassword=. 
You may also need to edit config/datasources/samples.mysql.sbs to set the proper 
database access values. 
 
For the Calendar example, you may need to update the file 
config/datasources/Calendar.xds so that the URLs reference the site on 
your server. 
 
For the e-commerce example, you will need to update the e-commerce provider 
file (config\datasources\test_cart.ecp) to point it to a working provider such 
as the one included with the preconfigured server package 
(http://localhost:port/DCServer/test_cart.php). 
 
Instructions for Installing Dynamic Content Examples — JSP 
The easiest thing to do is to install the preconfigured server package. 
 
To install them manually, first follow the PHP instructions above. You must 
install PHP to create the sample sites database. Create a context or web 
application named "samples_jsp“ that points to: 
 
<install dir>/Dynamic Content Examples/jsp/samples 
 
If you need to specify a server, database name, user name, or password for 
your MySQL installation, you may also need to edit 
config/datasources/samples.jdbc.sbs to set the proper database access values. 
 
For the Calendar example, you may need to update the file 
config/datasources/Calendar.xds to change the URLs to reference the site on 
your server. The same applies to the jsp/samples/calendar/Calendar.xsl file. 
 



For the e-commerce example, you will need to update the e-commerce provider 
file (config\datasources\test_cart.ecp) to point it to a working provider such 
as the one included with the preconfigured server package 
(http://localhost:port/DCServer/test_cart.php). 
 
Wireless Authoring Applications (Windows only) 
The GoLive 6.0 for Windows CD includes wireless emulation software for Nokia 
handsets, provided by Nokia for WML wireless authoring, and for NTT DoCoMo 
handsets, provided by  ACCESS for CHTML (i-mode) wireless authoring. The 
application installers are located inside the Wireless Authoring Emulators directory at 
the root level of the CD.  
 

• Nokia Phone Simulator Application: This application previews WML 
content that you author for Nokia or compatible phones. Please make sure 
that you register the Nokia Phone Simulator Application as a browser in 
GoLive 6.0, and read the separate ReadMe document that is contained in the 
same folder as the application on the CD.  
 
NOTE: Due to technical limitations, the Nokia Phone Simulator Application 
does not allow URLs with more than 100 characters. Use the Update option 
to check the Nokia Web site for improved versions of this application. 
 
 To start the emulator from within GoLive: 
 
Step 1 – Set up the emulator as a preview browser. Instructions are included 
in the GoLive 6 Wireless Authoring User Guide. 
 
Step 2 – Select "NokiaSimw.exe" from the Show in Browser button on the 
GoLive toolbar. Make sure you choose NokiaSimw.exe and not 
NokiaSim.exe. The application will start and you’ll see your deck in the default 
phone device emulator. Any links between cards in your deck should work in 
the emulator, so you’ll be able to navigate between cards in a deck. 
 
Step 3 – To display your card in other phone device emulators, choose 
Device > Create New Device, and then the device. 
 
Step 4 – When you make a change that you want to preview, choose the 
"NokiaSimw.exe" from the Show in Browser button on the GoLive toolbar. 
 
NOTE: Please check the Nokia site for newer versions of their Simulator 
Application. GoLive 6.0 takes you directly to the Nokia Site via Help > GoLive 
Links > Nokia downloads. A new Nokia Simulator Application version 
including XHTML-Basic support was announced for the timeframe GoLive 6.0 
shipped. 

 
• ACCESS CompactViewer for i-mode: The GoLive 6.0 for Windows CD 

includes simulation software for emulating the leading NTT DoCoMo i-mode 
handsets. This software has been provided by ACCESS (www.access.co.jp) 
and is called CompactViewer for i-mode. The application installer is located at 
the root level of the CD in the Wireless Authoring Emulators folder. Once you 



have installed CompactViewer on your system, you need to follow these 
steps to link it to GoLive 6.0: 

 
Step 1 – Copy the ACCESS Launcher folder from the GoLive 6.0 for Windows 
CD to your computer. (You can copy this anywhere to your system.) 
 
Step 2 – Start GoLive 6.0 and choose Edit > Preferences. 
 
Step 3 – Select Browsers in the Preferences dialog box and then click Add. 
 
Step 4 – Navigate to the area where you copied the ACCESS Launcher 
folder. 
 
Step 5 – Select ACCESS CompactViewer for i-mode.exe and then click 
Done. 
 
Once you’ve done this, you can jump to the ACCESS CompactViewer for 
previewing your CHTML pages. The current version of CompactViewer that 
comes with GoLive 6.0 only supports CHTML. 

 
For development information about Nokia WML, XHTML-Basic and MMS content, or 
NTT DoCoMo CHTML and XHTML-Basic content, please see the following URLs: 
 
 http://forum.nokia.com — Nokia 
 http://www.access.co.jp — ACCESS 
 http://www.nttdocomo.com — NTT DoCoMo 
 http://www.nttdocomo.co.jp 

 
Object Palette / Configure Sets 
GoLive 6.0 contains object sets for i-mode CHTML and XHTML Basic authoring. 
These sets are designed for NTT DoCoMo 501i, 502i, 503i, 3G FoMA and Nokia 
XHTML enabled handsets. Using the Objects palette menu, and choosing i-Mode 
10, i-Mode 20, i-Mode 30, or XHTML Basic 1.0 from the Configure submenu, the 
Objects palette displays objects that are compliant with the target technology. You 
may notice that the Floating Box object remains after choosing one of these 
configurations. Floating boxes are not supported on either of these platforms, but the 
DIV tag is. Since the object selection is based on the technology’s DTD files, and the 
Floating Box object is based on the DIV tag attribute, this item remains available but 
should not be used. 
 
Tech Preview: SMIL Authoring 
GoLive 6 ships with a new SMIL authoring module that lets you visually lay out SMIL 
documents and control SMIL timelines and embedded assets. This module and its 
documentation are located in a separate folder called SMIL Authoring inside the 
GoLive 6.0 application folder. Please consider this as a technology preview  the 
complete SMIL authoring functionality is under consideration for a later GoLive 
version. 
 
SMIL stands for "Synchronized Multimedia Integration Language" and is a W3C-
approved language that enables simple authoring of interactive audiovisual 



presentations. SMIL is typically used for rich media/multimedia presentations that 
integrate streaming audio and video with images, text or any other media type. 
 
The GoLive 6.0 SMIL module lets users create SMIL content using the same 
methods of page layout and time control that they are accustomed to using with the 
HTML editor and late stage interactive editor for QuickTime. The GoLive SMIL editor 
currently supports SMIL 1.0 and SMIL Basic standards, and lets you create content 
that can be viewed in many different players on multiple platforms, including 
RealPlayer, Apple’s QuickTime Player, and Nokia’s next generation messaging 
system — MMS (multimedia messaging system) for mobile phone messaging. 
 
The SMIL module is not activated as part of the standard installation, but can be 
very easily activated by performing the following steps: 
 

Step 1 – Open the SMIL Authoring folder located in the same directory as the 
GoLive 6.0 application. 
 
Step 2 – Copy the SMIL module and SMIL module data (Windows only) into 
the Modules folder located on the same level as the GoLive 6.0 application. 
 
Step 3 – Restart GoLive 6.0. 
 

Known issues: 
 

• RealONE Player has a problem with spaces in path names (don’t use spaces 
or ‘%20’ in path names). This issue may be addressed by Real in a future 
release of the RealONE Player. 

 
• RealPlayer 8 (Windows-only) has a problem with previewing temporary files 

(via 'Show In Browser'). Workaround: Open the saved file directly in 
RealPlayer. 

 
For further information on how to use the SMIL editor, see the SMIL authoring 
documentation in the SMIL Authoring folder located at the same directory level as 
the GoLive 6.0 application. 
 
-------------------------------------------------------- 
 
GoLive 6.0 Known Issues/Tips 
 
Adobe Online on Mac OS 9.1 

• Selecting Help > Registration and then choosing the top right option in the 
Registration Window, Hide Adobe GoLive, may cause the application to 
freeze. 

 
Double-byte Support using English GoLive 6.0 on MacOS X 

• The English version of GoLive 6.0 supports authoring for double-byte 
languages such as Japanese, Korean and Chinese. Mac OS 9 users only 
need to make sure the Encodings module is activated in the Preferences 
dialog box. Mac OS X users need to first make sure the Encodings module is 



activated and then need to run the GoLive Double-byte Registry for Mac OS X 
application. The Double-byte Registry is located in the OSX folder in the root 
level of the GoLive 6.0 for Mac OS CD. Simply start this application and select 
GoLive 6.0 to enable double-byte functionality on Mac OS X. 

 
GoLive Dynamic Content (General) 

• If you drag the "config" folder to the trash, you will not be able to install 
another language until you empty your trash or move the "config" folder back 
out of the trash. 

• PageGenerator is not supported on Mac OS9. 

• This release of GoLive does not support the preview of pages with XML 
content sources using relative URLs to the XML source. However, the page 
will work fine in production, just not in preview. 

• You may need to edit the data sources in the calendar and e-commerce 
sample sites to address your specific server configuration. 

• GoLive 6's source-mode editor displays incorrectly, and loses data, if the file 
is encoded in UTF-8.  Use a different character encoding to create and edit 
files in GoLive. 

• GoLive 6 does not delete the “___test” folder and files if you remove a format 
because they cannot be reliably removed from the server via FTP. You can 
always safely delete the test folder; it is used only during site creation to 
“___test” server capabilities. 

 
GoLive Dynamic Content (Double-byte support) 

• Tomcat 4.0 is the minimum requirement on a Japanese operating system. 
 
• In order to serve Japanese database content, it is required to enable multi-

byte string extensions in the php.ini file by deleting the comment tag from the 
"enable multi-byte" built-in function. 

• Apache does not support pathnames mapping to filenames that contain 
Japanese characters. 

 
• On Mac OS X’s Terminal application, PageGenerator’s usage message 

renders garbled characters due to bugs in the Mac OS X Terminal application. 
 
GoLive Dynamic Content (ASP) 

• In order to serve Japanese database content on an English Windows 
operating system, the system's regional settings need to be set to Japanese. 
In the Start Menu, select Control Panel then select Regional Settings, use the 
regions pop-up to select Japanese and click OK.  

 



GoLive Dynamic Content (JSP) 
• When using Tomcat as your Web server, be sure to restart Tomcat after you 

have published your site to the server. 

GoLive Dynamic Content (PHP) 
• Custom Merchant and XML processing, as well as double byte support, use 

features of PHP 4.1. PHP 4.0.6 and greater can be used for other PHP 
functions. 

GoLive Dynamic Content (XML datasources) 
• A pathname mapping that contains Japanese characters in the filenames 

requires writing conf/server.xml either in the UTF-8 character encoding, or 
with an encoding directive properly specified at the front of the file such as:  
<?xml version="1.0" encoding="Shift_JIS" ?> 

• UTF-8 encoded XML files are supported on ASP, JSP and PHP. 

• In XML datasources, PHP does not support the Shift_JIS XML file format. 
However, it is supported on ASP and JSP.  

• Datasource filenames containing Japanese characters are not supported. 
 
Please go to www.adobe.com for additional tips and application notes pertaining to 
GoLive Dynamic Content. 
 
FTP Connection 
GoLive supports absolute-only addresses (URLs) on FTP servers. You won’t be able 
to upload/download data to some other servers if they do not support absolute-only 
addresses. Furthermore, “virtual” Link file paths offered under Mac OS X cannot be 
resolved. 
 
For FTP connections, the option "Keep connections alive" is turned on by 
default in GoLive 6.0. If you do not wish to stay connected to an FTP server 
permanently after accessing it, choose Edit Server for the corresponding FTP 
server, and then select the Advanced tab to deactivate this option. 
 
Mac OS 9.x Filename Length Restrictions 
Mac OS 9.x supports a maximum filename length of 31 characters. When naming 
files under Mac OS X that does not carry this restriction, we nevertheless 
recommend this 31 character restriction be followed. This will prevent any access 
characters from being lost (which could result in broken links) on Mac OS 9.x.  
 
Filename Paths under Mac OS X 
GoLive uses Mac OS 9 paths for file URLs ("file:///..."). Since most browsers on 
Mac OS X use Mac OS X (POSIX) paths for file URLs, any absolute link or reference 
will not work. This includes images, hyperlinks, and the link to the JavaScript library. 
This problem will not occur when working with a site, since links within a site are 
never file URLs. 



GoLive 6.0 Extension for FrontPage 
The GoLive 6.0 extension for FrontPage is located on the Adobe GoLive CD in the 
Featured Extensions folder. It was designed presuming that your files will be on your 
local or network hard drives. If you have an active Adobe Web Workgroup Server 
and use it with the extension, you will find that it has limited functionality. Therefore, 
it is recommended that you follow the procedures detailed in the Extension for 
FrontPage documentation before using the Adobe Web Workgroup Server to 
manage the development of your site. 
 
EMOJI Fonts (Windows) 
If using Emoji fonts, the ACCESS CompactViewer for i-mode must be installed and 
running before starting GoLive. 
 
Interactive 

• QuickTime Authoring: Saving (flattening) a movie with a movie track freezes 
the GoLive application on Windows ME/98, when either the child or parent 
movie is located on the desktop (this is a QuickTime-related problem). 
Workaround: When using movie tracks, make sure that none of the child and 
parent movies are located on the desktop. 

 
• The QuickTime 3D Track is not supported under Mac OS 10.1. 

 
• QuickTime plugin: Under Mac OS X, make sure to also copy the QuickTime 

Plugin.plugin file from the system’s Library/Internet Plug-ins folder into the 
GoLive 6.0 folder holding the browser plug-ins. Otherwise you will not be able 
to preview QuickTime files in GoLive 6.0 under Mac OS X. 

 
Integration 

• While layer-based image maps created in ImageReady are not supported you 
can use those maps created with the ImageReady map tool.  Although their 
map shapes are not visible, and therefore not editable in GoLive, these maps 
will still work in a Web browser after having applied the Smart Objects 
workflow. They may also be edited directly in ImageReady, benefiting from 
the SmartObject workflow provided in GoLive. 

 
• SWF files created with LiveMotion 2: When you include SWF files created 

with LiveMotion 2 into your site, you need an additional plug-in to manage all 
links within these files. This plug-in is delivered with the LiveMotion 2 
package, and must be installed in the Adobe GoLive 6.0/Modules/Plugins 
folder. For further instructions, please see your LiveMotion 2 documentation. 

 
• When working with SVG files including Smart Object Variables, do not use 

the "embed fonts" options in Illustrator’s SVG Settings dialog. Embedding a 
font that is slightly different than the font installed on a system may lead to an 
incorrect layout when applying a text variable. 

 
• Smart Illustrator Objects — Variable Replacement for SVG or SVGZ image 

files: SVG or SVGZ files supplied with variables should be saved with CSS 
properties "Presentation Attributes" only (which is the default setting in the 
Illustrator SVG Options Save dialog box), to ensure Variable Replacement 



workflow in GoLive. For any other CSS properties (like Style Attributes, Style 
Attributes (Entity References), Style Elements) variables wouldn’t be 
supported in GoLive. The CSS properties settings are available in a sub 
dialog box that opens if the user clicks the "Advanced" button. 

 
• Smart Object Linking. A Smart Object should never be linked to the same 

image file for the Source AND the target. This is not a standard workflow and 
may cause problems. 

 
Mapping the Web Workgroup Server to an XP Drive 
It is not possible to map the Web Workgroup Server to an XP Drive (XP only uses 
port 80 while Workgroup uses port 1102). However, it is possible to connect to a 
Workgroup server via Network Folders or by using the Internet Explorer  “Open as 
WebFolder” option. 
 
Script Library 
Internet Explorer 5.1 for Mac OS X cannot load the script library in the GoLive 
application folder. (This script library is used for pages outside a site.) Workaround: 
Set stand-alone pages (that is, pages not in a site) with actions attached to “Write 
Code Into Page.” 
 
Site Management (General) 
When working with large sites in GoLive on Mac OS 9.x, you may have to increase 
the application memory size of GoLive to avoid possible memory problems. 
 
Site Management (Anchor Names) 
When Anchor names are changed, you will not be prompted with an update dialog 
box. To make the respective changes, please use Find & Replace. Anchors will be 
properly updated if the location of the anchor reference changes (changing the 
anchor name only is a known issue). For workgroup-enabled sites only, anchors will 
not show up in the Files tab of the Site unless the file is checked out. 
 
Site Management (Converting a Local Site to Workgroup Site) 
If you want to convert your local site to a workgroup site, please adhere to these 
guidelines: 
 

• The site file must be, as in the *standard* site, next to the other site folders 
(*site*, .data, .settings). 

 
• The site must not be renamed. 

 
These guidelines are important to follow if you create a local site using “Import from 
Folder” and then plan to convert the local site into a workgroup site. 
 
Web Settings 
Please note that Web Settings are saved on your local hard disk. If you work on a 
workgroup server, they will not automatically be transferred to other work places. So, 
you’ll need to make sure all persons in the workgroup use the same settings. 
 



WebDAV (Mac OS X only) 
When establishing a WebDAV connection from Mac OS 10.1.1 to the AWW server, 
files may be automatically written to the server. This appears to be a specific Mac 
OS X issue, which cannot be addressed directly by GoLive. 
 
Adobe Web Workgroup Server 
Workgroup Server performance may dramatically decrease if the hard disk of the 
machine running the server and database is very fragmented. Performance may 
improve by defragmenting the disk. 
 
The “Refresh” function (see Site Settings) automatically updates the External, 
Colors, and Font Sets tabs in the site window. To get the latest changes from the 
server for the Files, Diagrams, Library, and Extras tabs, you must manually refresh 
the view by clicking the Refresh View button. 
 
Non-GoLive client applications connecting to the Workgroup site via WebDAV may 
be prompted to enter a password multiple times. 
 
Adobe Web Workgroup Server Administration 
The first time pages are loaded into the browser for Workgroup Admin, these .jsp 
pages will load slowly since they need to be compiled for first-time use. Any time 
thereafter, however, page-loading performance is much improved. 
 
When setting up the production environment for workgroups, creating user accounts 
is one of the foremost administration tasks. The Adobe Web Workgroup Server 
respects access permissions assigned to each team member by an administrator. 
As administrator, you manage site access and decide whether or not a user gets 
administrator privileges. With administrator privileges assigned, you have full access 
to the system  no restrictions. Without administrator privileges assigned, you can 
log onto the server, check work in and out, and create and publish sites from within 
the GoLive client. You cannot perform any administration tasks at all. 
 

• Login Enabled OFF: The user cannot log onto the Workgroup Server 
independent of the privileges assigned. 

 
• Login Enabled ON/Administrator Privileges OFF: The user can log onto the 

server via a WebDAV compatible client, e.g. GoLive, but cannot use the 
browser-based Administration client. 

 
• Login Enabled ON/Administrator Privileges ON: Full access to the system via 

any WebDAV compatible client including the browser-based Admin. 
 
A root system administrator is installed with the system. This initial user is vested 
with the highest level of privileges and can access and edit all areas of the system. 
The system account appears at the top of the User List. You can neither delete it, 
nor change its full name, nor modify its access privileges. 
 



Defining a Default Publishing Server 
The documentation incorrectly states that only FTP servers can be assigned as the 
default publishing server. This no longer applies. You can define both FTP and File 
servers as the default publishing server. 
 
Default URL Encoding 
The default URL encoding used by the server complies to that used by the host 
computer’s operation system. That is, if you run the Workgroup Server on a 
Japanese operation system, it will by default use the Japanese system’s encoding. 
In the Site Settings under URL Handling, you can change the encoding to UTF-8. 
This is especially recommended when you need to cover multiple languages. 
 
Adobe Web Workgroup Server Disk Space Management 
Ample disk space for Workgroup-enabled sites is critical, in particular when you work 
with large sites over a long period, involving complex link structures that cause the 
database to grow considerably. If you experience server or client errors, we 
recommend to verify available disk space required by the database to ensure 
unhindered operation. 
 
Adobe Web Workgroup Server User Name and Password 
Please avoid using any special characters when entering a user name or password. 
 
Workflow Extension in GoLive Client  
The Workflow extension, if enabled (by selecting Edit Menu > Preferences > 
Modules), may cause a slowdown in performance when working with workgroup-
enabled Web sites. 
 
Connecting to the Adobe Web Workgroup Server using WebDAV  
The Adobe Web Workgroup Server uses  by default  “digest“ authorization. If 
the client only supports “basic” authorization, the server switches automatically back 
to “basic“. If in some cases this does not work automatically, proceed as follows: 
Open Adobe Web Workgroup \webapps\contact\WEB-
INF\datamodel\config.properties. Under the General System Settings you will find a 
command line that looks like this: 
 
#use digest authorization instead of basic 
system.useDigestAuthorization: on 
 
Change “on“ to “off“ and restart the server. 
 

• If you want to connect from Mac OS X to the Workgroup Server using 
WebDAV & digest mode, you have to update to Mac OS 10.1.1. Otherwise 
switch to basic mode (see above). 

 
• If you use Photoshop as a client, use the IP number of the Workgroup Server 

instead of a name in the Workflow dialog box. 
 
Converting a local site to a workgroup site 
If you want to convert your local site to a workgroup site, please adhere to these 
guidelines: 



 
• The site file must be, as in the *standard* site, next to the other site folders 

(*site*, .data, .settings). 
 
• The site must not be renamed. 

 
These guidelines are important to follow if you create a local site using “Import from 
Folder” and then plan to convert the local site to a workgroup site. 
 
Converting a workgroup site to a local site 
First thing to remember here is, that in the workgroup case, the default behavior for 
a file is to be on the server and not on the client machine. Files that are already on 
the client machine might not represent the latest version. Consequently, a mere 
import from folder of what is there will likely not generate the expected result. 
 
1) Check out all files and do a fresh import from folder — just downloading files 
would result in all files having local locks. These locks would likely carry over to a 
new site that would be quite inconvenient. If this site is to remain a workgroup site, 
check in all files again! 
 
2) All workgroup sites can be found on the server machine in the file system. When 
a site is imported to the server, it is not lost. All files are still in the file system and the 
metadata is stored and handled in the database. So another valid option is to go to 
the server machine and make a copy from 
<...AWWS/wgdata/sites/sitefoldername/sitefolder>. 
 
-------------------------------------------------------- 
 
GoLive 6.0 Undocumented Features 
 
Integration 

 
Import Photoshop Layers as Floating Boxes: 
  This corresponds to the former "Import Photoshop as HTML" (File Menu > 
Import >...) 

• Photoshop Layer Effects and Layer Sets are supported in GoLive 6.0. 
 
• New: Holding down Shift-key while selecting "Import > Photoshop 

Layers to Floating Boxes", flattens the Photoshop Layer Set contents 
into one layer (floating box) in GoLive. 

 
• Unchanged since GoLive 5.0: Holding down Alt key while selecting 

"Import > Photoshop Layers to Floating Boxes", imports the lowest 
Photoshop layer (…) as a background image in GoLive, instead of 
creating a floating box with an image. 

 
Using EPS and PDF as Smart Objects 
You may link the source of a Smart Object to an EPS or PDF file type to have 
the benefit of the live connection maintained with the original files. 
 



CMYK support 
• GoLive 6.0 supports CMYK 8bit .psd files.  
 
• CMYK .tif and CMYK 16bit .psd files remain unsupported. 

 
Smart LiveMotion Object 
Unlike in GoLive 5.0, LiveMotion .liv files do not have to be explicitly set to 
"Export: SWF" in LiveMotion before they can be used as source files for 
GoLive Smart Objects. 
 
Matte Color Settings for Smart Objects 
In addition to the Save for Web, or Matte Color dialog boxes, the matte color 
for a Smart Object can be set via a context menu or simply by dragging a 
color out of the preview pane of the Color palette. 
 
Smart Objects folder (Site Extras) 
Here is a better way to organize source files associated with a given site: In 
the site’s Extras tab (see right pane of the site window), there is a 
SmartObjects folder created by default. If you add the original source files to 
this folder (.psd, .ai, .liv, and so on), these files will help you with file 
organization and never be uploaded to the Web server, which is the desired 
behavior. 
 
Support for Security PDF Files 
GoLive 6.0 now also supports password protected, so-called Security PDF 
files (except Acrobat Self-Sign Security). 
 
When adding such a PDF file to a GoLive 6.0 site, you will be asked to enter 
the Open password for this PDF file. After this, you may be prompted to enter 
a master password (also called Security password), which gives you full 
access to the PDF file. Without the master password provided, for instance 
you will not be able to change links for this file. In the GoLive 6.0 site window 
the status will then display the “?” symbol for invalid links. 

 
NOTE: When importing password-protected PDF files into your site, you can 
suppress the password-access dialog boxes by pressing Shift-Ctrl. This can 
be useful when importing large sites with a number of password protected 
PDF files and different passwords to speed up the import process. You will be 
asked for the passwords the first time you want to open the PDF or reparse 
the site. If you want to suppress password-access dialog boxes coming up 
when reparsing the site, define a URL filter for PDF files (see below for more 
info on URL filters). 

 
Site Management: Reparsing a File Selection 
GoLive software’s reparsing functionality checks files in a site for incoming and 
outgoing links. Normally, reparsing will be activated: 

• when you add new files to a site, or 
• when you hold the "Alt" key and choose Refresh View on the Site toolbar, or 
• when you hold the "Alt" key and choose Site-Refresh View from the menu, 

which then brings up the option Reparse All. 



 
New with GoLive 6.0 is the possibility to only reparse selected files. You will find a 
corresponding Reparse Selection command in the Site menu that can be applied to 
any selection within your site. Reparsing selections is helpful when modifiying single 
files outside of GoLive and modifying links related to these files. When adding them 
back to the site reparsing can be restricted to these specific files. Also, you can force 
bringing up the password dialog box for password-protected PDF files with a 
selected reparse. 
 
URL Filter (URL Handling Preferences / URL Handling Site Settings)  
This option lets you specify patterns, like file extensions or directory paths, that you 
want GoLive to ignore when checking for link errors. By specifying “/cgi-bin/” you 
can, for example, prevent GoLive from searching for and marking CGI scripts that 
are not available on your local platform as broken links. To create a new filter pattern 
indicating files that are to be ignored, click the New Item button at the bottom of the 
scroll list, type an extension or directory pattern in the bottom text box, and press 
Return. 
-------------------------------------------------------- 
 
Adobe Technical Support 
 
Adobe CustomerFirst offers person-to-person support directly from Adobe 
Systems. Complimentary phone support is included, for a limited time, with each 
product you license and register, and additional Pay-As-You-Go options and annual 
support contracts are available to meet your ongoing support needs. For more 
information in U.S. and Canada, refer to the Adobe Direct Support Programs pages 
at <http://www.adobe.com/support/cfdetails.html>. For more information in the 
United Kingdom, refer to the Adobe Direct Support Programs pages at 
<http://www.adobe.uk/support/main.html>. For more information in Australia, New 
Zealand, and the Pacific, refer to the Adobe Direct Support Programs pages at 
<http://www.adobe.com.au/support/main.html>. 
 
When you register GoLive as a first time buyer, you are entitled to technical support 
for up to 90 days from the date of your first call. As an upgrade customer, you are 
entitled to technical support for up to 30 days from the date of your first call. Terms 
may vary depending on the country of residence. 
 
For technical support in other countries, please visit the Adobe support pages at 
<http://www.adobe.com/support/intlsupport.html> to locate an Adobe Support Center 
near you. 
 
Customer Support on Adobe Online 
Adobe Online provides access to FAQs (Frequently Asked Questions) and 
troubleshooting information that provides solutions to common problems. Explore 
the extensive customer support information on Adobe’s World Wide Web site 
(<http://www.adobe.com>). To access the Adobe Web site from GoLive, choose 
Help > Adobe Online or click the Adobe Online button on the toolbar. 
 



Additional Customer Support Resources 
Adobe Systems provides several forms of automated technical support. For 
information, refer to the Adobe technical support pages at 
<http://www.adobe.com/support/main.html>. 
 

• ReadMe Files: See the ReadMe files installed with the program for 
information that became available when the product shipped. 

 
• Search the Support Knowledgebase: Search Adobe’s knowledgebase for 

answers and browse the top issues lists at 
<http://www.adobe.com/support/database.html>.  

 
• Training: Self-paced online lessons, training books and videos, Adobe 

Certified Training Providers, events and seminars to help you get the most 
from your Adobe products. 

 
• User-to-User Forums: Share your Adobe product questions and experiences 

with other Adobe users. 
 

• Support Announcements via E-mail: Stay current on the latest news from the 
Adobe User Forums community, and receive announcements about the latest 
technical how to‘s, patches, and plug-ins for selected Adobe products. 

 
• Tutorials and Tips & Tricks: Suggested workflows, underlying concepts, and 

step-by-step problem solving for Adobe products presented in a graphically 
rich format. For information, refer to the Adobe GoLive Tutorials pages at 
<http://www.adobe.com/products/tips/golive.html>. 

 
-------------------------------------------------------- 
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